
STATISTICS

Version 6

 

User Manual



© 2006 BRUKER OPTIK GmbH, Rudolf-Plank-Straße 27, D-76275 Ettlingen, www.brukeroptics.com

All rights reserved. No part of this manual may be reproduced or transmitted in any form or by any
means including printing, photocopying, microfilm, electronic systems etc. without our prior written
permission. Brand names, registered trademarks etc. used in this manual, even if not explicitly marked
as such, are not to be considered unprotected by trademarks law. They are the property of their
respective owner.

The following publication has been worked out with utmost care. However, Bruker Optik GmbH does
not accept any liability for the correctness of the information. Bruker Optik GmbH reserves the right to
make changes to the products described in this manual without notice.

This manual is the original documentation for the OPUS spectroscopic software.



iii

Table of Contents
Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1

1 Multi Evaluation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3
1.1 Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1.1.1 IDENT Evaluation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
1.1.2 Conformity Test  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
1.1.3 QUANT Evaluation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
1.1.4 Store  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
1.1.5 Statistics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
1.1.6 Blending . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

1.2 Test . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

2 Setup File List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

3 Statistics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
3.1 Maximum/Minimum Value  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
3.2 Mean Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
3.3 Standard Deviation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
3.4 Variance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34





Bruker Optik GmbH OPUS/STATISTICS 1

Introduction
OPUS STATISTICS is a software package which consists of three parts. The
first part describes the automated evaluation of NIR spectra for qualitative and
quantitative analysis in combination with IDENT, QUANT and conformity test
methods.

To statistically evaluate spectra series a spectra file list is required. The second
part of this manual outlines how to set up such a file list.

Statistical evaluation features, including different evaluation functions, are
described in the third part. These functions are used to evaluate single spectrum
files, different spectra files which are part of a common file list, or even 3D
files.
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1 Multi Evaluation
The Multi Evaluation function in the OPUS Evaluate menu allows the
automated evaluation of NIR spectra for qualitative or quantitative analysis. It
combines IDENT, QUANT and conformity test methods with the results being
displayed in one single report.

If you want to identify an unknown sample, the multi evaluation enables you to
first perform an IDENT analysis. Based on the result obtained OPUS continues
with a QUANT analysis using the same sample. This procedure can be helpful
in many cases to check whether the product to be used for a quantitative
analysis has been measured at all. The combination of an IDENT analysis and
conformity test may similarly be appropriate.

Multi evaluation parameters are stored in a special method file with the
extension *.ME. Before you can start a multi evaluation you have to create a
multi evaluation method. If you want to edit the multi evaluation path of this
method, make sure that you have the right to change parameters. To verify the
user rights select the User Settings command in the Setup menu, and click on
the 21CFR11 Rights tab. For further details, see chapter 14 in the OPUS
Reference Manual.

1.1 Setup

To start the multi evaluation analysis you have to set up a method or load a
method which has been previously created. Click on the Multi Evaluation Setup
command in the Evaluate menu to open the following dialog:

CMELoadPropertyPage$IHO_FUNCTION_ME_SETUP
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To load an existing method click on the Load Multi Evaluation Method button
and select the particular method from the dialog that opens. 

Depending on the kind of evaluation you want to perform on the original
spectrum or spectra set up a new method by means of the other evaluation
option tabs available. The evaluation options correlate with each other, i.e. the
sequence of product analysis shall be as follows:

1) IDENT (no further test)
2) IDENT → Conformity Test
3) IDENT → Conformity Test → QUANT
4) IDENT → QUANT
5) Conformity Test → (no further test)
6) Conformity Test → QUANT
7) QUANT (no further test)

The sequences 2 and 4 allow to identify the product in a first step by using the
No Reference defined IDENT test option.

If you use the IDENT Evaluation with several substance groups, and the multi
evaluation test result shows that several groups may apply to the product to be
evaluated, any further test would not be reasonable. This result, however, will
only be generated if the basic IDENT library had not been validated properly
and overlappings had not been eliminated either.

Figure 1:  Multi Evaluation Setup - Load Method tab
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Otherwise, if only one substance group applies, you can continue by performing
the Conformity Test and/or QUANT Evaluation. This test depends on the
substance group selected for the IDENT Evaluation. 

It is also possible to perform the multi evaluation analysis by the Conformity
Test only. If one conformity test method turns out to be successful, you can
continue with the QUANT Evaluation. 

Integrating a previous QUANT method, without performing an IDENT or
conformity test, can be useful if the original QUANT result has been corrected
by, e.g. offset correction, or if warning or alarm limits have to be set.

As soon as you close the Multi Evaluation Setup command without saving the
changes made the following dialog pops up:

This dialog pops up even if you have not made any changes on the method at
all, but clicked on one of the IDENT, Conformity Test or QUANT Multi
Evaluation tabs.

Figure 2:  Multi Evaluation Setup - pop-up dialog
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1.1.1 IDENT Evaluation

The Active check box is deactivated by default and thus all functions and
controls are disabled and grayed. Activate the Active check box. If you activate
the Change IDENT method check box, you can select the appropriate IDENT
method from the drop-down list. 

Note: All IDENT, Conformity Test and QUANT methods used for multi
evaluation have first to be copied to the sub-directories of the multi evaluation
root directory. The following default setting applies:

...\OPUS\MultiEvaluation
\Conformity Test Method
\IDENT Method
\QUANT Method

These paths will be created in OPUS not until the Multi Evaluation Setup
command has been selected for the very first time. The base path can be changed
by means of the User Settings command in the Setup menu.

Confirm the choice by clicking on the Accept Method Change button. The name
of the IDENT method file with the extension *.FAA will be displayed in the
upper selection field (see A in figure 4).

Figure 3:  Multi Evaluation Setup - IDENT Evaluation tab

CMEIdentPropertyPage$IHO_FUNCTION_ME_SETUP
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The Change IDENT method check box and the drop-down list will be
deactivated again.

For the IDENT analysis two alternative evaluation modes are available. The
mode No reference defined (see figure 3) works without a pre-defined reference
spectrum and allows the complete analysis of all substances available in the
IDENT library. This, however, requires the substances to be part of one
validated IDENT library, and further evaluation methods, e.g. QUANT, to be
assigned properly.

To work with an expected reference group check the Expected reference group
option button. The reference group selected on this tab will always be set as
default on all the other tabs. To change the reference group activate the Change
expected group check box and select the particular group from the drop-down
list. This list includes all groups of the current IDENT library.

Confirm the choice by clicking on the Accept Group Change button. The name
of the reference group selected will be displayed in the upper selection field (A
in figure 5), and the Change expected group check box and the drop-down list
will be deactivated again.

All the settings made on the Conformity Test and QUANT Evaluation tab
correlate with the expected reference defined.

A

Figure 4:  Identity Test Method group field

Figure 5:  Evaluation Mode group field

A
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1.1.2 Conformity Test

Activate the Active check box. If you have defined an expected reference group
on the IDENT Evaluation tab, the upper drop-down list includes the name of the
reference group defined, and will be deactivated. If no reference group has been
defined, the drop-down list will be activated and you can select the desired
group of the IDENT library (see figure 7).

Assign an individual conformity test method to the selected IDENT library
group. Activate the Change conformity test method check box and select the
appropriate method from the drop-down list. Confirm the choice by clicking on
the Accept Change button (see figure 8).

Figure 6:  Multi Evaluation Setup - Conformity Test tab

Figure 7:  Select Product for Assignment

CMEConfoPropertyPage$IHO_FUNCTION_ME_SETUP
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If the settings are made, click on the Add button (see figure 9). A table will be
displayed including the assignments made, and the name of the conformity test
method. To remove a particular assignment from the list, select the
corresponding line and click on the Delete button.

Figure 8:  Select Conformity Test Method

Figure 9:  Method List of Conformity Test
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1.1.3 QUANT Evaluation

Activate the Active check box. If you have defined an expected reference group
on the IDENT Evaluation tab, the upper drop-down list includes the name of the
reference group, and will be deactivated. If no reference group has been
defined, the drop-down list will be activated and you can select the desired
group of the IDENT library. 

Assign an individual QUANT or INTEGRATION method to the selected
IDENT library group. Activate one of the Quantitative analysis method option
buttons and select the appropriate method from the drop-down list. 

In case of QUANT 1 and INTEGRATION you can also select between different
data preprocessing methods. The methods include Vector Normalization, 1st
and 2nd Derivative and combinations of both methods. Frequently, the Vector

Figure 10:  Multi Evaluation Setup - QUANT Evaluation tab

Figure 11:  Quantitative Analysis Methods

CMEQuantPropertyPage$IHO_FUNCTION_ME_SETUP
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Normalization method is used to preprocess data. In many cases, however, you
even get better results if you select 1st or 2nd Derivative. For further details on
the preprocessing methods, see chapter 8 in the OPUS Reference Manual.

In the Parameters group field you can specify additional values which are set to
0 by default. 

Activate the Correction of result check box and apply a formula from the drop-
down list. If you want to create a new formula for the correction of analysis
results, click on the Create Formula button. The following dialog pops up:

By means of the Load Formula button you can load an existing formula with
the file extension *.for. The string code begins with the Adjusted_Result = term,
and you can add up to 4 different variables: 

Figure 12:  Parameters group field

Figure 13:  Correction Formula Calculator
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• 1 variable for the result predicted by the method
• 3 variables for input values which can be set during spectra

evaluation

If you click on the Add Input... button(s) or Predicted Result button or on one of
the figure buttons, the string code will be extended according to the entries
made. 

Example: Adjusted_Result = Predicted_Result * 3.01/Add_input 1 * Add_input 2/5.2

Always use the Calculator block which includes brackets, decimal point and the
four basic arithmetic operations. To save the new formula click on the Save as...
button. Make sure that you use a valid formula which does not produce any
arithmetic error.

No recommendations can be made for the values to be entered for Target
Concentration or the highest allowable standard deviation in case of several
analysis (Maximum% RSD). The optimum value has to be determined
empirically.

Depending on the test result warning and alarm limits can be set in case of the
concentration and average value limit. As soon as the warning limit defined will
be exceeded, a warning is given and informs you where the error has occurred.
If all parameters have been set, click on the Add button to have the method list
displayed. The warning and alarm values will be set to 0 again. In this way
customized evaluation methods and parameters can be assigned to different
components.

The analysis method list includes all the parameters set. The figure displayed in
the Method column refers to the method selected, i.e.:

0 = QUANT 2
1 = QUANT 1
2 = INTEGRATION

To remove a particular assignment from the list, select the corresponding line
and click on the Delete button.

Figure 14:  Quantitative Analysis Method List
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1.1.4 Store 

To finish the multi evaluation setup procedure click on the Store Method button.
The method will be stored in the OPUS MultiEvaluation directory which root
path can be defined in the Setup menu by means of the User Settings command,
provided you have the necessary user rights. For the MultiEvaluation directory
the default root path will always be the currently used local OPUS directory.

Figure 15:  Multi Evaluation Setup - Store tab

CMELoadStorePropertyPage$IHO_FUNCTION_ME_SETUP
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1.1.5 Statistics

The settings made on the Statistics tab have no effect on the multi evaluation
method stored. Drag & drop spectrum files or file lists into the File(s) to
Evaluate selection field. Select a statistics evaluation function from the drop-
down list and define the block size. For further details on the different statistics
evaluation functions, refer to chapter 3.

When clicking on the Check button a multi evaluation analysis will be
performed. The result of this analysis forms the basis for the subsequent
statistical evaluation. 

1.1.5.1 Statistical evaluation of QUANT or 
INTEGRATION results

The results produced by a QUANT or INTEGRATION evaluation can also be
subject to statistical evaluation. The result of this statistical evaluation will be
displayed in the OPUS Online window.

Click on the Statistics tab and Drag & Drop a file list, i.e. the LIST data block
( ), from the OPUS browser to the File(s) to Evaluate selection field. Make
sure that you use the LIST data block only, as OPUS will not accept any other
data block in this case.

Figure 16:  Multi Evaluation Setup - Statistics tab

CMEStatisticsPropertyPage$IHO_FUNCTION_ME_SETUP
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Select the kind of statistical evaluation and click on the Check button. Each type
of evaluation will be performed (ME, QUANT and STATISTICS), while the
different spectra belonging to the file list will be loaded into the OPUS browser.

As soon as the evaluation has been finished, the OPUS Online window pops up
automatically and displays the statistical evaluation results.

Figure 17:  Statistical evaluation with LIST data block

Figure 18:  Spectra loaded belonging to the file list
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The evaluation result is displayed in the form of bands. These bands show the
direct result of the multi evaluation analysis as well as the statistical evaluation
result. The button at the top of the display (A in figure 19) has the same color as
the corresponding band. 

If the evaluation has been finished, the TRC ( ) data block will be attached
to the file list in the OPUS browser window. Double clicking on this data block
allows to have the result displayed in a report view.

A

Figure 19:  Result view of statistical evaluation
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1.1.6 Blending

The settings made on the Blending tab have no effect on the multi evaluation
method stored. This tab can be used to define an integration method and a data
preparation method, and to interactively set integration limits. 

Activate the Active check box and enter the name of the component into the
entry field. Select one of the data preprocessing methods from the drop-down
list.

Figure 20:  Multi Evaluation Setup - Blending tab

Figure 21:  Select Data Preprocessing Method

CMEBlendingPropertyPage$IHO_FUNCTION_ME_SETUP
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Define an integration method which specifies the frequencies for one or more
areas which are to be integrated. 

The following integration methods are available:

• Method A:
Integration is performed using zero as baseline.

• Method B: 
A straight line is drawn between the intensity values of the frequency
limits specified. The area above this line is integrated.

• Method P:
The intensity at the frequency specified in the From entry field will
be applied.

To set the frequency limits either enter the values into the entry fields or click
on the Interactive Frequency Selection button. The interactive frequency
selection is possible both for single spectra and spectra lists.

If you activate the Active check box in the Correction Formula group field, you
can either select a formula from the drop-down list, if available, or create a new
formula. For any further details on how to create a formula, refer to
chapter 1.1.3.

If you click on the Add button, the integration limits and integration method
selected (A, B or P) will be grouped into a new method. This method will be
registered as new line in the matrix of QUANT methods together with the name
of the component and the data preprocessing. 

If more than one QUANT method is defined, always the result of the first
method indicated in the list will be considered. The name of the method consists
of: Blend_Name of the component_Left integration limit_Right integration limit
Random value (see figure 23).

Figure 22:  Select Integration Method

Figure 23:  Quantitative Analysis Method List
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1.2 Test

Start the multi evaluation by clicking on the Multi Evaluation Test command in
the Evaluate menu. The following dialog opens:

Drag & drop the file(s) to be tested from the OPUS browser window into the
File(s) for Multi Evaluation Test selection field. 

Click on the Load Multi Evaluation Method button and load the particular
method. Normally, the path of the method previously used is displayed above
this button. 

The Values for Quantitative Analysis tab displays the three input variables
defined by means of the formula calculator (see figure 25).

Figure 24:  Multi Evaluation Test - Select Files tab

CMETestPP2$IHO_FUNCTION_ME_TEST
CMETestPP1$IHO_FUNCTION_ME_TEST 
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Start the multi evaluation analysis and click on the Test button. Each step
performed during multi evaluation will be indicated by the status bar. The multi
evaluation results are stored in an ME data block ( ) and displayed in a
special report (see figure 26).

The multi evaluation test report contains the test name and path as well as the
results of the different method tests, e.g. QUANT, IDENT or Conformity Test
(A in figure 26). The Multi Evaluation final test status is indicated by either
ERROR, REGULAR, UNCHECKED, WARNING or ALARM (B in
figure 26). 

Figure 25:  Multi Evaluation Test - Values for Quantitative Analysis tab

Figure 26:  Multi Evaluation report

A

B
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If, e.g., in the QUANT evaluation method the upper and lower concentration
limit defined for warning or alarm differs, the final result is checked against
these limits. 

The concentration limits are not taken into account if all concentration limits are
set to 0 (default setting). If they are not evaluated, the status is reported as
UNCHECKED unless an ERROR occurs. Any ALARM supersedes a
WARNING. An error occurs if, e.g., a data block type does not correspond to a
method.
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2 Setup File List
Several spectra of a particular spectrum type can be combined into one common
file list, and edited as one single spectrum. The list which consists of different
spectra is stored in the LIST data block ( ), and displayed when selecting
the respective data block.

All OPUS commands available for manipulating and evaluating spectra data
can be used for the complete spectra file list in the same way as being used for
single spectra files.

To create a spectra file list click on the Setup File List command in the Edit
menu, and click on the Add Spectra button to load the particular spectra. 

Figure 27:  LIST data block 

Figure 28:  Setup File List - Different spectra

CMultiFilePropertyPage1$IHO_FUNCTION_FILELIST
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By default, the path and file name of each spectrum is displayed in a table. This
table can be customized, i.e. enlarged by as many columns as you like, e.g. to be
able to store parameters and input values required for evaluation functions.
Enter the name of the column into the entry field below the Add Row button. If
you click on this button, the new column will be added to the table.

To store the spectra file list click on the Save Spectra List button. Define a
specific name for the list. Spectra file lists are stored as reports in the OPUS
format. The file extension of the list may be incremented, i.e. automatically
increased by 1. This is especially helpful if you want to use the same name for
different spectra file lists.

In case of evaluating single spectra you can also add specific parameter values
to the table in the form of a column. Make sure that you always enter the right
parameter code for the specific value into the entry field. The parameter code
can be obtained from the Macro Editor, also see the OPUS Programming
manual.

If you want to add, e.g. the Mahalanobis distance in case of a QUANT
evaluation, or the outlier identification for each single spectrum from the
QUANT report to the spectra file list, you first have to create an INFO data
block (see also chapter 4 in the OPUS reference manual.)

Select the Add Information command in the Edit menu. Enter the following data
into the Compound name line (figure 29): name of the OPUS function (A),
result data block (B) as well as the corresponding element from the QUANT
report (C), i.e. main report number, sub-report number, line, column.

To perform a statistical evaluation load the file list, which you have created, by
means of the Load File command from the File menu. Select the Statistics
command from the Evaluate menu. For details, see chapter 3. As the list is
regarded as one spectrum file, the statistical evaluation result will be displayed
as follows.

Figure 29:  Example of an information input

             A          B       C
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Note that the single spectrum files which make up the file list will all be
manipulated after the evaluation statistics has been performed. The
manipulation will be indicated by the red symbol in front of the file name. 

To restore the original spectrum files, click on the Undo Changes command in
the File menu.

Figure 30:  File list parameters

Figure 31:  Spectra file list with manipulated files
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3 Statistics
OPUS STATISTICS provides statistical information on single spectra, file lists
or 3D spectra files. As even a thorough statistical evaluation cannot rule out all
potential analytical problems, the process of method development and
validation should address the most common ones.

The OPUS Statistics function serves as a basis for the statistical evaluation of
quantitative results by means of the Multi Evaluation function (see
chapter 1.1.5). If you directly use the Statistics function, this may only allow a
statistical performance on the spectra themselves, which may not be very
helpful in case of routine analytics. Therefore, the following chapter has to be
seen as reference to the different evaluation methods available in OPUS, and
outlines them in more detail by means of a single spectrum.

To start the statistical evaluation select the Statistics command in the Edit menu.
Drag & drop the file(s) to be evaluated into the File(s) to evaluate selection
field.

Select a statistical evaluation function from the respective drop-down list and
enter the number of data points manually into the Block size entry field. To get
reasonable results always define a meaningful block size. Start the statistical
evaluation by clicking on the Evaluate button.

Figure 32:  Statistics dialog 

CStatisticsPP$IHO_FUNCTION_STATISTICS
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The statistical evaluation in OPUS is based on different evaluation functions
which are described in the following:

• Maximum/minimum value
• Mean value
• Standard deviation 
• Variance

3.1 Maximum/Minimum Value

OPUS determines the previous maximum or minimum value of data points.
Note that this kind of statistical evaluation function will overwrite the original
spectrum. 

Figure 33:  Example of Maximum Value function
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3.2 Mean Value

The mean value of a spectrum is defined as the sum of all data points divided by
the number of data points. Mean is another word for the arithmetic average. In
case of normal frequency distribution, the mean value is located at the center
with most values clustered around the mean and the frequency of occurrence
decreasing from this central point. 

 

Figure 34:  Example of Minimum Value function
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Figure 35:  Normal frequency distribution
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The total area beneath the curve can be defined as being equal to 1.00 (or as
100% of the data points distributed around the mean).

This kind of statistical evaluation function is used to decrease the noise within a
spectrum. In case of the Mean Value statistical evaluation function you can
either select between

• moving block (average is calculated from all data points)
• fixed block (average is calculated from defined block only)
• overall block (average is calculated from the entire spectrum).

If you use the Fixed Block Mean function, the average value is displayed by
horizontal sections, see figure 37. This applies to single spectra, file lists and 3D
files. 

Figure 36:  Example of Moving Block Mean function

Original spectrum

Result of evaluation
function
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Using the Overall Block Mean function means that the statistical evaluation
result is stored in the data block report. To have these parameters displayed in
case of single files or file lists, right click on the red file symbol of the spectra
file in the OPUS browser window and select the Show Parameter command
from the pop-up menu. The parameters are displayed as follows:

If you use 3D files in connection with the Overall Mean statistical evaluation
function, the result will be stored in a TRC data block ( ) which is appended
to the manipulated file.

Figure 37:  Example of Fixed Block Mean function

Figure 38:  Data parameters report
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3.3 Standard Deviation

The standard deviation is defined as the square root of the variance
(chapter 3.4). Advantages of using the standard deviation over variance
function are:

• The standard deviation is expressed in the measurement units of the
data.

• The standard deviation is easily calculated from the variance.
• The areas below the curve of normally distributed data points can be

precisely calculated for a given range.

In case of the Standard Deviation evaluation function you can either select
between

• moving block (useful if no or minor signal changes are expected)
• fixed block 
• overall block.

If you use the Fixed Block Standard Deviation function, the standard deviation
is displayed by x-axis sections, see figure 40. This applies to single spectra, file
lists and 3D files. 

Figure 39:  Example of Moving Block Standard Deviation function

Result of evaluation function
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Using the Overall Block Standard Deviation function means that the evaluation
result is stored in the data block report. To have these parameters displayed in
case of single files or file lists, right click on the red file symbol of the spectra
file in the OPUS browser window and select the Show Parameter command.
The parameter is displayed as follows:

If you use 3D files in connection with the Overall Block Standard Deviation
evaluation function, a TRC data block ( ) is appended to the manipulated
file.

Figure 40:  Example of Fixed Block Standard Deviation function

Result of evaluation function

Figure 41:  Data parameters report
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3.4 Variance

The variance of a random variable x is a measure of its statistical dispersion,
indicating how far from the expected value its values typically are. The
disadvantage of the Variance evaluation function is that the variance has a
different unit than the data. This is the reason why in many cases one uses the
standard deviation which is defined as square root from the mean value. 

The variance is based on the following equation:

 with n being the number of data points per block size, 

and s2 the variance.

In case of the Overall Block Variance statistical evaluation function n is the
number of data points of the entire spectrum.

In case of this kind of evaluation function you can either select between

• moving block 
• fixed block 
• overall block.

If you use the Fixed Block Variance function, the variance is displayed by x-
axis sections, see figure 43. This applies to single spectra, file lists and 3D files. 

s2 Σx2 Σx )2 n⁄(–
n 1–

------------------------------------=

Figure 42:  Example of Moving Block Variance function

Result of evaluation function
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Using the Overall Block Variance function means that the evaluation result is
stored in the data block report. To have these parameters displayed in case of
single files or file lists, right click on the red file symbol of the spectra file in the
OPUS browser window and select the Show Parameter command. The
parameter is displayed as follows:

If you use 3D files in connection with the Overall Block Variance evaluation
function, a TRC data block ( ) is appended to the manipulated file.

Figure 43:  Example of Fixed Block Variance function

Result of evaluation function

Figure 44:  Data parameters report
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